
 

บทที ่2 
การใชงานโปรแกรมเบื้องตน 

 
 
 
 
 
 
2.1 การสรางแบบจําลอง (Model Generation) 

ในโหมดการสรางแบบจําลอง จะเปนขัน้ตอนแรกในการทํางานกับ STAAD/Pro เมื่อเปด
ใชงาน โปรแกรมจะเขาสูโหมดการสรางแบบจําลองโดยอัตโนมัติ ในขั้นตอนนี้ผูใชจะตอง
จําลองโครงสราง กําหนดคณุสมบัติ จุดรองรับ และแรงที่กระทําตอโครงสราง 

 
 
 
 
 
 
 
 
การเขาสูโปรแกรม STAAD 

เมื่อเรียกใชโปรแกรม STAAD จากชุด STAAD/Pro Design Studio จะมีกลองโตตอบให
เลือกประเภทของโครงสรางดังภาพที ่ 2.01 ซ่ึงไดอธิภายไวในภาคผนวก ก. และใหเลือก
หนวยที่ใชในการปอนขอมูลดังภาพที่ 2.02 

 
เพจคอนโทรลสําหรับการสรางแบบจําลอง (The Pages in Modeling Mode) 

หนาหลักและหนายอยสําหรับโหมดการสรางแบบจําลองสามารถสรุปไดดังตารางที ่ 2.01 
และภาพที่ 2.04 ดังตอไปนี ้

นอกจากการสรางแบบจําลองดวยวิธีกราฟกในวินโดวแลว ผูใชยังสามารถใชชุดคําสั่ง 
(Command File) ซ่ึงสามารถสรางโดยโปรแกรมพิมพขอความทั่วไป เชน Notepad เปน
ตน ดวยรูปแบบคําสั่งที่คลายคลึงกับภาษาองักฤษ งายตอการทําความเขาใจ ดัง
รายละเอียดในคูมือที่มากับโปรแกรม ตัว STAAD/Pro เองก็มีตัวพิมพมาใหเชนกัน เรียก 
Edit Command File ซ่ึงถาทําการแกไขดวยชุดคําสั่งแลว แบบจําลองในวินโดวกจ็ะทํา
การปรับปรุงตัวเองโดยอัตโนมัติ 

NOTES 
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ภาพที่ 2.01  เลือกประเภทของโครงสราง 
 
 
 
 
 
 
 
 
 

ภาพที่ 2.02  เลือกหนวยในการปอนขอมูล 
 
 
 
 
 
 
 
 
 

ภาพที่ 2.03 ยืนยนัความถกูตอง 

เลือกประเภทของโครงสราง 

ช่ือโครงการ 

เลือกหนวยความยาว เลือกหนวยของแรง 

ตรวจสอบความถูกตองและยืนยัน 
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ภาพที่ 2.04  เพจคอนโทรล 

 
ตารางที่ 2.01 คําอธิบายของเพจคอนโทรล 

หนาหลัก หนายอย จุดประสงค 
Setup Job ใชปอนขอมูลคําอธิบายของงานที่ทํา เชน ช่ือโครงการ ช่ือ

เจาของ การแกไขแบบ เปนตน 
Geometry Beam ทําการสรางองคอาคารขึ้นระหวางจุดตอที่กําหนด โดยการใช

ตารางกริดชวยในการสรางในแบบกราฟก หรือโดยปอนขอมูล
ในตารางพิกัดของจุดตอ ตารางรายละเอียดองคอาคาร เปนตน 

 Plate สรางเอลิเมนตแบบแผนขึ้นระหวางจุดตอที่กําหนด ในทํานอง
เดียวกันกับช้ินสวนคาน 

 Solid สรางเอลิเมนตแบบตันขึ้นระหวางจุดตอที่กําหนด 
General Property กําหนดคุณสมบัติของชิ้นสวน เชน หนาตัด วัสดุ เปนตน โดย

กําหนดชื่อคุณสมบัติดวยตัวเลข เพื่อสามารถอางอิงไดในตาราง
คุณสมบัติขององคอาคารแบบตางๆ 

 Spec กําหนดคุณสมบัติพิเศษของชิ้นสวน เชน รีลีส หรือองคอาคาร
รับแรงดึงอยางเดียว เปนตน 

 Support สรางจุดรองรับที่มีดีกรีความอิสระตามตองการ 
 Load กําหนดน้ําหนักบรรทุกที่กระทําตอโครงสราง 
Analysis/Print Pre-print กําหนดรายการที่ตองการใหแสดงในไฟลแสดงผล กอนทําการ

วิเคราะห 
 Analysis กําหนดวิธีการวิเคราะหที่ตองการใช 
 Post-print กําหนดรายการที่ตองการใหแสดงในไฟลแสดงผล หลังทําการ

วิเคราะห 
Design Steel กําหนดคาตัวแปรที่เกี่ยวของในการออกแบบ 
 Concrete  
 Timber  
 Aluminum  
 Footing  
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หนายอย Setup > Job 
เมื่อเขาสูโปรแกรมแลว สวนแรกทีจ่ะตองทําคือการใสขอมูล เพื่อเปนคําอธิบายของ
โครงการ ดังแสดงในภาพที่ 2.05 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 2.05 หนายอย Setup > Job 
 
 
 
 
 
 
 
 
 
 
 

 
ภาพที่ 2.06  รายละเอียดเพิม่เติม 

รายละเอียดโครงการ 

รายละเอียดของไฟล 

คําอธิบายเพิ่มเติม 

ช่ือผูออกแบบ/ตรวจสอบ 

ดูภาพที่ 2.06 

องคอาคารในโครงสราง 
เชน จํานวนจุดตอ คาน 
เปนตน 

คําสั่งที่มีการเรียกใช 
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หนายอย Geometry > Beam 
เมื่อเขาสูขั้นตอนนี้ โปรแกรมจะแสดงตารางจุดตอ (Nodes Table) ดังภาพที่ 2.07 และ
ตารางคาน (Beams Table) ดังภาพที่ 2.08 ซ่ึงตารางทั้งสองมีความสัมพันธกัน เนือ่งจาก
ตารางคานจะอางอิงถึงจุดตอที่มีในตารางจุดตอ ประกอบกับแสดงคณุสมบัติอ่ืนดวย  

 
 
 
 

 
 
 
 
 
 
 
 

ภาพที่ 2.07 ตารางจุดตอ 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 2.08  ตารางคุณสมบัติคาน 
 

หมายเลขจุดตอ 

พิกัดตามแนวแกน x y z ของ
จุดตอ 

หมายเลขคาน 

หมายเลขจุดตอเริ่ม/
จุดตอปลาย 

คุณสมบัติของจุดตอ 

ความยาวของคาน 

คามุมเบตา 
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หนายอย Geometry > Plate 

สําหรับแบบจาํลองที่ประกอบดวยเอลิเมนตแบบแผน มสีองตารางที่เกี่ยวของคือ ตารางจุด
ตอเชนเดยีวกบัหนายอย Beam และตารางชิ้นสวนแบบแผน (Plates Table) ซ่ึงมีขอแตกตาง
กันตรงที่ช้ินสวนแบบแผน 1 ช้ินจะประกอบดวย 3 หรือ 4 จุดตอ ดังแสดงในภาพที่ 2.09 

 
 
 
 
 
 
 

ภาพที่ 2.09  ตารางชิ้นสวนแบบแผน 
 

หนายอย Geometry > Solid 
สําหรับแบบจาํลองที่ประกอบดวยเอลิเมนตแบบตัน มสีองตารางที่เกี่ยวของคือ ตารางจุด
ตอเชนเดยีวกบัหนายอย Beam และตารางเอลิเมนตแบบตัน (Solids Table) ซ่ึงมีขอแตกตาง
กันตรงที่ช้ินสวนแบบแผน 1 ช้ินจะประกอบดวย 8 จุดตอ  
 

หนายอย General > Property 
เปนขั้นตอนการสรางขอมูลคุณสมบัติทางกายภาพ (Physical Properties) และคุณสมบัติ
วัสดุ (Material Properties) ของชิ้นสวนหรือเอลิเมนต รูปแบบคุณสมบัติหนาตัดไดอธิบาย
ไวในภาคผนวก ก.04 
 เมื่อเขาสูหนายอย โปรแกรมจะแสดงกลองโตตอบ Properties ซ่ึงประกอบดวย
สองแท็บคือ Section และ Beta Angle ดังแสดงในภาพที่ 2.10 เมือ่ผูใชเลือกหนาตัดที่
ตองการตามวธีิการที่เหมาะสม คุณสมบัติที่สรางขึ้นรูปแบบตางๆ จะแสดงอยูในรายการ
อางอิง (Ref)  

เมื่อทําการแกไขขอมูลในตาราง เชน ตารางจุดตอ หรือตารางคาน โปรแกรมจะทําการ
ปรับปรุงแบบจําลองโดยทันที ทั้งขอมูลตารางและขอมูลกราฟก และในทางกลับกันดวย 

NOTES 

หมายเลขแผน หมายเลขจุดตอ คุณสมบัติของเอลิเมนต 
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ภาพที่ 2.10 การกําหนดคณุสมบัติ 
 
เมื่อคลิกที่ Values… โปรแกรมจะแสดงตารางรายละเอียดของคุณสมบัติที่สรางขึ้นหรือ
เลือกไว พรอมหมายเลขอางอิง ดังแสดงตวัอยางในภาพที่ 2.11 
 
 
 
 
 

ภาพที่ 2.11 ตารางรายละเอียดคุณสมบัตทิี่สรางขึ้นหรือเลือกไว 
 
เมื่อคลิกที่ Database… จะแสดงกลองโตตอบดังภาพที่ 2.12 ซ่ึงจะเปนการเลือกหนาตดั
เหล็กมาตรฐาน ที่มีอยูแลวในโปรแกรมดงัอธิบายในภาคผนวก ก.04 โดยสามารถเลือกได
หลายประเทศ เชน อังกฤษ อเมริกัน เปนตน สวนคุณสมบัติวัสดุโปรแกรมจะกําหนดคา
เร่ิมตนใหเปน Steel (เหล็ก) ซ่ึงเราอาจจะเลือกเปนอยางอื่นก็ได 

 

หมายเลขอางอิงพรอมคําอธิบายอยางยอ 

สวนชวยสราง
คุณสมบัติที่
ตองการ สวนกําหนดคา

คุณสมบัติ ใหแก
องคอาคารตาม
ตองการ 

1

2 

3
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ภาพที่ 2.12 ตารางเหล็กมาตรฐาน 
 
เมื่อคลิกที่ Define… จะเปนการนิยามหนาตัดตามตองการเชน ส่ีเหล่ียม วงกลม รูปตัวที 
เปนตน และสามารถกําหนดคุณสมบัติวัสดใุหเปน คอนกรีต/เหล็ก/อลูมิเนียม หรือกําหนด
ภายหลังก็ได ดังภาพที่ 2.13 
 
 
 
 
 
 
 
 
 
 

 
ภาพที่ 2.13  การนิยามหนาตัดดวยการกําหนดคณุสมบัติตางๆ ตามตองการ 

 

ถาตองการเลือกคุณสมบัติวัสดุแบบอื่นให
คลิกเครื่องหมายถูกออก แลวคอยกําหนด
ภายหลัง 

TIPS 
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เมื่อคลิกที่ Materials… โปรแกรมจะแสดงตารางรายละเอียดคุณสมบัติวัสด ุ ที่มีอยูใน
ฐานขอมูลโดยปกติจะมี 3 อยางคือ คอนกรีต เหล็ก และอลูมิเนียม 
เมื่อคลิกที่ Thickness… จะเปนการกําหนดความหนาใหแกเอลิเมนตแบบแผน ดังแสดงใน
ภาพที่ 2.14 จะเห็นไดวาสามารถกําหนดความหนาของแผนที่แตกตางกันไดที่ส่ีมุม แตถา
ตองการกําหนดความหนาคงที่ อาจจะกําหนดคาที ่Node 1 เพียงจดุเดยีวก็ได 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 2.14 การกําหนดความหนาใหเอลิเมนตแบบแผน 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

การกําหนดคณุสมบัติที่สรางขึ้นหรือเลือกไว ใหแกองคอาคารหรือเอลิเมนตทํา
ไดหลายวิธี ดงัตอไปนี้  
- Assign to Selected Beams โดยเลือกคณุสมบัติที่ตองการจากรายการทีเ่ตรียม

ไวแลว แลวทําการเลอืกองคอาคารหรือเอลิเมนตที่ตองการกําหนดคา
คุณสมบัติดังกลาวใหดวยเมนู Select แลวเลือก Assign to Selected Beams 
แลวกดปุม Assign 

- Assign to View ใชในการกําหนดคณุสมบัติใหแกทุกองคอาคารหรือเอลิ
เมนตในมมุมองปจจุบัน ทําไดโดยเลือกคุณสมบัติทีต่องการจากรายการที่
เตรียมไว แลวเลือก Assign to View แลวกดปุม Assign 

- Use Cursor to Assign เปนการใชเคอรเซอรที่เหมาะสมเลือกองคอาคารที่
ตองการจากหนาจอ ทําไดโดยเลือกคณุสมบัติที่ตองการจากรายการทีเ่ตรียม
ไว แลวเลือก Use Cursor to Assign แลวกดปุม Assign แลวจึงใชเคอรเซอร
เลือกองคอาคารหรือเอลิเมนตที่ตองการ 

 

NOTES 
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การกําหนดมมุเบตา (ดูภาคผนวก ก.) ทําไดโดยคลิกเลอืกแท็บ Beta Angle จากภาพที่ 2.10 
โปรแกรมจะแสดงกลองโตตอบดังภาพที่ 2.15 ทําการปอนคามุมเบตาแลวกําหนดใหแก
องคอาคารหรือเอลิเมนตที่ตองการ 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 2.15 การกําหนดมมุเบตา 
 
หนายอย General > Spec 

เปนสวนทีใ่ชกําหนดเงื่อนไขพิเศษใหแกจดุตอ (Node) องคอาคาร (Beam) หรือเอลิเมนต
แบบแผน (Plate) ซ่ึงจะมีคณุสมบัติพิเศษแตกตางจากเงือ่นไขปกติของโปรแกรม ดังได
อธิบายในภาคผนวก ก. รูปแบบของกลองโตตอบแสดงในภาพที่ 2.16 ประกอบดวย 3 สวน 
เชนเดยีวกับการกําหนดคณุสมบัติ (General > Property) ไดแก สวนแสดงรายการ สวน
สรางหรือเลือกคุณสมบัติ และสวนกําหนดคุณสมบัติใหแกองคอาคาร 
เมื่อเลือก Node... จะมีรายการ Master/Slave ดังคําอธิบายในภาคผนวก ก. ผูใชสามารถที่จะ
รีลีสดีกรีความอิสระได โดยคลิกที่ Rigid ดังภาพที ่2.17 แตถาไมแกไขก็หมายถึงจดุตอตาม
จะเชื่อมโยงกบัจุดตอนําอยางแข็งเกร็ง (Rigid)  
เมื่อเลือก Beam… โปรแกรมจะแสดงกลองโตตอบดังภาพที่ 2.18 ซ่ึงผูใชสามารถกําหนด
คุณสมบัติตางๆ ขององคอาคารไดตามที่อธิบายในภาคผนวก ก.  
เมื่อเลือก Plate… จะแสดงกลองโตตอบดังภาพที่ 2.19 ซ่ึงเปนคุณสมบัติสําหรับเอลิเมนต
แบบแผน 
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ผูใชสามารถทําการกําหนดคณุสมบัติที่ตองการโดยการ Add เขามาในรายการดังภาพที ่
2.16 สวนที่ 1 แลวจึงทําการ Assign ใหแกเอลิเมนตหรือองคอาคารที่ตองการตอไป 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 2.16 การกําหนดเงือ่นไขเพิ่มเติม 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 2.17  Node Specification 
 
 
 

1 

2 

3

รายการเงื่อนไขที่เลือก 

สวนชวยสรางเงื่อนไขที่
ตองการ 

สวนกําหนดคาใหแกองค
อาคารหรือเอลิเมนต 
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ภาพที่ 2.18 Beam Specification 
 

 
 

 
 
 
 
 
 
 
 
 
 

ภาพที่ 2.19  Plate Specification 
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หนายอย General > Support 
การกําหนดจดุรองรับใหแกโครงสรางทําไดโดย สรางรูปแบบจุดรองรับดวยการคลิกปุม 
Add ในภาพที ่ 2.20 แลวทําการ Assign ใหแกโครงสรางในตําแหนงจดุตอที่ตองการ สวน
ปุม Edit จะใชในการแกไขคณุสมบัติของจดุตอที่มีรายการอยูแลว ในตารางโดยตรง 
 ภาพที่ 2.21 ถึง ภาพที่ 2.25 แสดงการกําหนดจุดตอแบบตางๆ 
 
 
 
 
 
 
 

 
ภาพที่ 2.20 กลองโตตอบสําหรับกําหนดจุดรองรับ 

  
 
 
 
 

 
 

ภาพที่ 2.21 จุดรองรับแบบยึดแนน (Fixed Support) 
 
 
 
 
 
 
 

ภาพที่ 2.22 จุดรองรับแบบหมุน (Pinned Support) 

2
สวนชวยสรางจุดรองรับ
ที่ตองการ 

1

3 สวนกําหนดคาใหแกองค
อาคารหรือเอลิเมนต 

รายการจุดรองรับที่เลือก
ไว 

ตัวเลือกนี้ไมสามารถ
แกไขได แตแสดงใหเห็น
จุดบังคับ (Restraint) ที่
เลือก สําหรับจุดรองรับ
แบบยึดแนน 
กดปุม Create เพื่อยืนยัน 

ไมสามารถแกไขได
เชนเดียวกับจุดรองรับ
แบบยึดแนน 
แตจุดบังคับมีแค 3 คาคือ  
FX FY และ FZ  
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ภาพที่ 2.23  จุดรองรับแบบมีเงื่อนไข (Fixed but …) 
 
 
 
 
 
 
 
 
 

ภาพที่ 2.24  จุดรองรับสําหรับฐานราก 
 
 
 
 
 
 
 
 
 

ภาพที่ 2.25  จุดรองรับเอียง 

Release หมายถึงยอมให
เลื่อนที่หรือหมุนไดตาม
ทิศทางที่เลือก 
แตถาไมเลือกคาใด ก็จะ
เปนจุดตอแบบยึดแนน 
เชนเดิม  

การกําหนดจุดรองรับ
แบบสปริง คือ ยอมให
เลื่อนที่หรือหมุนไดตาม
ทิศทางที่เลือก ภายใตคา
นิจ (K) ที่กําหนด 
ตามสมการ F = Kx 

เลือกชนิดของจุดรองรับ 
ถาเปน Footing จะสามารถ 
กําหนดขนาดได  
ถาเลือก Elastic Mat หรือ 
ฐานแพ คือเปนสปริงตัว
เดียวตอหนึ่งจุด  

เลือกทิศทางของสปริง  

กําหนดความตานทานของ
ดิน คลายกับคานิจ (K) 
ของสปริง  

สวนนี้เปนเชนเดียวกับจุด
รองรับแบบมีเงื่อนไข ภาพ
ที่ 2.23  

กําหนดจุดอางอิงเพื่อแสดง
ความเอียง  
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หนายอย General > Load 
การกําหนดน้ําหนักบรรทุกทีก่ระทําตอโครงสรางทําไดโดย เลือกหนายอยGeneral > Load 
โปรแกรมจะแสดงกลองโตตอบดังภาพที่ 2.26 ใหกําหนดชุดของน้ําหนักบรรทุกที่ตองการ 
เมื่อเลือกแลวจะเขาสู วินโดวกําหนดคาน้ําหนักบรรทุก ดังภาพที่ 2.27 ทําการสรางน้ําหนัก
บรรทุกที่ตองการจากตวัเลือกตางๆ ดังภาพที่ 2.28 ถึง 2.32 แลวจึงทําการ Assign ใหแกองค
อาคารตอไป 
 
 
 
 
 
 
 

ภาพที่ 2.26 กําหนดชุดของน้ําหนกับรรทุก 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 2.27 ตัวสรางน้ําหนกับรรทุกแบบตางๆ 
 

ต้ังช่ือชุดน้ําหนักบรรทุกใหม   หรือคําอธิบาย 
หมายเลขอางอิง    

กรณีที่มีชุดน้ําหนักบรรทุกเดิมอยูแลว ตองการเลือกเพื่อทําการแกไข 

สรางชุดน้ําหนักบรรทุก (Load Case) ใหม 

1 

รายการน้ําหนักบรรทุกที่
สรางไว 

2

3 

ตัวเลือกน้ําหนักบรรทุก
แบบตางๆ 

สวนกําหนดคาใหแกองค
อาคารหรือจุดตอ 
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ภาพที่ 2.28a แรงกระทําที่จดุตอ (Nodal Loads-Node) 
 
 
 
 
 
 

 
 

ภาพที่ 2.28a แรงกระทําที่จดุตอ (Nodal Load-Fixed End) 
 
 
 
 
 
 

 
 

ภาพที่ 2.28a แรงกระทําที่จดุตอ (Nodal Load-Support Displacement) 
 
 
 

- สัญลักษณ Fx Fy Fz แสดงวาเปนแรง สวน Mx My Mz เปนโมเมนตซ่ึงกระทํา
ในระบบพกิัดโกลบอล (ดูภาคผนวก ก.) 

- การเลื่อนที่ของจุดรองรับมีหนวยดังแสดง สวนการหมนุมีหนวยเปนองศา 

NOTES 

คาการเคลื่อนที่
ของจุดรองรับ 
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ภาพที่ 2.29a แรงกระทําที่องคอาคาร (Member Loads) – แรงแผกระจายคงที่ 

 
 
 
 
 
 
 
 
 
ภาพที่ 2.29b แรงกระทําที่องคอาคาร (Member Loads) – แรงกระทําเปนจุด 

 
 
 
 
 
 
 
 
 
ภาพที่ 2.29c แรงกระทําที่องคอาคาร (Member Loads) – แรงแปรผันเปนเสนตรง 

ระยะจากจุดศูนยกลาง
แรงเฉือน 

ทิศทางตามโลคอล 

ถาคาd1, d2 เทากับศูนยจะ
ถือวาน้ําหนักกระทําเต็ม
ความยาวคาน 

แรงตอหนวยความยาว ตําแหนงจุดเริ่มตน 

ตําแหนงจุดสิ้นสุด 

ทิศทางตามโกลบอล 
ทิศทางตามระยะฉาย
ของชิ้นสวนบนพิกัด 
โกลบอล 

แรงกระทําเปนจุด 

ทิศทางตามโลคอล 

ขนาดของแรงที่จุดกึ่งกลาง 
คาน 

ขนาดของแรงที่ปลายคาน 

ขนาดของแรงที่จุดเริ่มตน 

TIPS 

สําหรับทิศทาง PX PY PZ 
แมวาแรงจะกระทําบนระยะ
ฉายของคานบนแกนโกบอล
แตระยะ d ยังคงวัดตามความ
ยาวคาน 

TIPS 
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ภาพที่ 2.29d แรงกระทําที่องคอาคาร (Member Loads ) – แรงแผกระจายรูปสี่เหล่ียมคางหมู  

 
 
 
 
 
 
 
 
 

ภาพที่ 2.29e แรงกระทําที่องคอาคาร (Member Loads ) - แรงดันน้ํา 
 
 
 
 
 
 
 
 
 

ภาพที่ 2.29f แรงกระทําที่องคอาคาร (Member Loads) – แรงบนแผนพื้น (ดภูาคผนวก ก.) 

ขนาดและตําแหนงของ
แรงที่จุดเริ่มตน 

ขนาดและตําแหนงของ
แรงที่จุดสิ้นสุด 

สําหรับแรงดันน้ํา จะตอง
เลือก (Select) องคอาคารที่
ตองการกอน จึงจะสามารถ
กําหนดคาตางๆ ได 

TIPS

แกนโกลบอลที่ตองการให
โปรแกรมเฉลี่ยคา W1, W2 

คาแรงดันน้ําที่จุดสูงสุด/ตํ่าสุด 
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ภาพที่ 2.29g แรงกระทําที่องคอาคาร (Member Loads) – แรงจากการอัดแรง (ดภูาคผนวก ก.) 

 
 
 
 
 
 
 
 
 

ภาพที่ 2.30a แรงกระทําที่เอลิเมนตแบบแผน (Plate Loads) – แรงอัด 
 
 
 
 
 
 
 
 
 
ภาพที่ 2.30b แรงกระทําที่เอลิเมนตแบบแผน (Plate Loads) – แรงแผกระจาย 

เมื่อ X1 Y1 X2 Y2 เทากับ
ศูนยจะถือวาแรงแผกระจาย
เต็มหนาตัด 
แตถากําหนดเฉพาะ X1 Y1
แรงจะกระทําเปนจุดที่พิกัด
ดังกลาว 

TIPS 
แรงอัดตอหนวยพ้ืนที่หรือ
แรงเปนจุด (แลวแตกรณี) 

พิกัดเมื่อเทียบกับจุด
ศูนยกลางของเอลิเมนต 

แรงตั้งฉากกับเอลิเมนต 

ทิศทางตามพิกัดโกลบอล 
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ภาพที่ 2.30c แรงกระทําที่เอลิเมนตแบบแผน (Plate Loads) – แรงดันน้ํา 

 
 
 
 
 
 
 
 
 

ภาพที่ 2.31a แรงเนื่องจากอุณหภูมิ (Temperature Loads) 
 
 
 
 
 
 
 
 
 

ภาพที่ 2.31b แรงเนื่องจากความเครียด (Strain) 

อุณหภูมิที่แตกตางที่
ปลายสองขางทําใหเกิด
การยืดหดตามแนวแกน 

อุณหภูมิที่แตกตางที่ผิวบน
และผิวลาง (บน-ลาง) ทําให
เกิดการดัด 

คาความเครียดบวกเปนการยืด
ตัว คาลบเปนการหดตัว 
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ภาพที่ 2.32   แรงจากน้ําหนกัตัว (Selfweight Load) 
 

หนายอย Analysis/Print > Pre-print 
เปนขั้นตอนในการกําหนดขอมูลที่ตองการใหแสดง กอนที่จะทําการคํานวณวิเคราะห ใน
ไฟลผลลัพธของ STAAD/Pro (นามสกุล .ANL)  

เมื่อเลือกหนายอย Analysis/Print > Pre-print โปรแกรมจะแสดงกลองโตตอบดัง
ภาพที่ 2.33  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 2.33  ตัวเลือกการแสดงผลขอมูลกอนการวิเคราะห 

คาตัวคูณปรับแกคาที่คํานวณ
จากความหนาแนนและ
ปริมาตร 
สวนเครื่องหมายลบแสดง
ทิศทางตรงกันขามกับแกน
พิกัดบวก 
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จะเห็นไดวารายการในภาพที ่ 2.33 เปนชุดคําสั่งทั้งหมดในแฟมงานนี้ ซ่ึงแสดงอยูในรูป
สัญลักษณ  หมายถึงเปนรายการหลักซึ่งมีรายการยอยอยูภายใน สวนสัญลักษณ  
แสดงวารายการนี้ไมสามารถแกไขไดในขัน้ตอนนี ้

เมื่อคลิกที่ Define Command… โปรแกรมจะเปดกลองโตตอบ ดังแสดงในภาพที่ 
2.34 ซ่ึงประกอบดวยตวัเลือกการแสดงผลตางๆ ทําการเลือกแท็บที่แสดงคําสั่งที่ตองการ
แลวคลิก Add จะทําใหคําสั่งที่เลือกแสดงในรายการในภาพที่ 2.33 โดยมีสัญลักษณ  ซ่ึง
หมายถึงคําสั่งยังไมสมบูรณ ปดหนาตางดังภาพที่ 2.34 ดวยการคลิก Close แลวคลิกที่
ชุดคําสั่งซึ่งมีสัญลักษณ  เพื่อทําการ Assign คําสั่งใหแกองคอาคารหรือเอลิเมนตตอไป 
จะทําใหรายการดังกลาวแสดงดวยสัญลักษณ   

 
 
 
 
 
 
 
 
 
 
 

 
ภาพที่ 2.34  ตัวเพิ่มรายการแสดงผลเขาไปในชุดคําสั่ง 

 
รายละเอียดคําอธิบายคําสั่งตางๆ ในภาพที่ 2.34 มีดังตอไปนี้ 

Problem Statistics แสดงรายละเอยีดจํานวนจุดตอ องคอาคาร ความจุของ
แฟมขอมูลที่ตองการเปนตน 

Joint Coordinates แสดงคาพิกัดของจดุตอ 
Member Information แสดงรายละเอียดทั้งหมดขององคอาคาร เชน ความยาว มุม

เบตา การรีลีส เปนตน 
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Element Information แสดงรายละเอียดของเอลิเมนตแบบแผน เชน ความหนา 
อัตราสวนปวซอง เปนตน 

Solid Information แสดงรายละเอียดของเอลิเมนตแบบตัน ไดแก อัตราสวนปว
ซอง เปนตน 

Member Properties แสดงคุณสมบัติของหนาตัด ไดแก พื้นที่หนาตดั โมเมนต
ความเฉื่อย เปนตน 

Material Properties แสดงคุณสมบัติสําหรับองคอาคาร ไดแก คาโมดูลัสยืดหยุน 
คาโมดูลัสการเฉือน ความหนาแนน เปนตน 

Support Information แสดงรายละเอียดของจุดรองรับ ไดแก การจับยดึ การรีลีส 
คาคงที่ของสปริงที่ใช เปนตน 

All แสดงรายละเอียดหลายๆ ขางตน รวมกนั 
Cg แสดงคาพิกัดของจุดศนูยถวงของโครงสราง 

 
หนายอย Analysis/Print > Analysis 

ในทํานองเดียวกับ Pre-print แตสําหรับ Analysis จะแสดงขอมูลที่เกี่ยวของการขั้นตอนการ
วิเคราะห เชน ขอมูลน้ําหนกับรรทุก การตรวจสอบเชิงสถิตย เปนตน ดังแสดงในภาพที่ 
2.35 เมื่อคลิกที่ Define Commands จะแสดงกลองโตตอบ ดังภาพที่ 2.36 ซ่ึงมีหลายแท็บ 
โดยทั่วไปแลวจะสนใจเฉพาะแท็บ Perform Analysis สวนตัวเลือกอื่น ไดแก Nonlinear 
Analysis, P-delta Analysis และ Change เปนตัวเลือกสําหรับการวิเคราะหขั้นสูง เชน การ
วิเคราะหแบบไมเปนเชิงเสน ซ่ึงไมขอกลาวในทีน่ี ้

รายละเอียดตัวเลือก ในหวัขอ Perform Analysis สามารถสรุปไดดังตอไปนี้ 
No Print ไมแสดงขอมูลใด 
Load Data แสดงขอมูลน้ําหนักบรรทุก 
Statics Check ตรวจสอบผลรวมของแรงภายนอก แรงปฏิกิริยาที่จุดรองรับ รวมทั้ง

โมเมนตของแรงดังกลาวที่จดุกําเนดิ 
Statics Load เชนเดียวกับ Statics Check แตเพิ่มการแสดงผลรวมของแรงภายนอก 

และแรงภายใน ที่แตละจุดตอดวย 
Mode Shapes แสดงคาดังกลาวที่จุดตอ 
Both มีคาเทากับ Load Data รวมกับ Statics Check 
All มีคาเทากับ Load Data รวมกับ Statics Load 
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ภาพที่ 2.35  หนายอย Analysis/Print > Analysis 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 2.36  ตัวเลือกการแสดงผลในขั้นตอนวิเคราะห 
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หนายอย Analysis/Print > Post-print 
เปนขั้นตอนในการกําหนดขอมูลผลจากการคํานวณวิเคราะห ที่ตองการใหแสดงในไฟล
ผลลัพธของ STAAD/Pro (นามสกุล .ANL) ซ่ึงเมื่อเขาสูหนายอย Analysis/Print > Post-
print ดังแสดงในภาพที่ 2.37 และเมื่อเลือกตัวเลือกที่ตองการดวย Define Command… จะ
แสดงกลองโตตอบดังภาพที่ 2.38  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 2.37  หนายอย Analysis/Print > Post-print 
 
Load List แสดงชุดน้ําหนักที่เลือก 
Section กําหนดหนาตดัในชิน้สวนคานที่ตองการใหแสดงคาโมเมนตและแรง 
Joint Displacement แสดงคาการเสียรูป (เล่ือนที่, หมุน) ของจุดตอ 
Member Forces แสดงแรงในชิ้นสวน เชน แรงตามแนวแกน แรงเฉือน โมเมนต 

ในรูปแบบตารางสําหรับทุกชุดน้ําหนัก 
Support Reactions แสดงคาแรงปฏิกิริยาในรูปแบบตาราง 
Force แสดงคาเอนเวลโลป (Envelopes) ของโมเมนตและแรงสําหรับชิ้นสวนที่

ตองการ 



 
บทที่ 2 การใชงานโปรแกรมเบื้องตน 

 

40

Max Force แสดงคาแรงและโมเมนตที่สูงสุดและต่ําสุด  
Story Drift แสดงคาการเคลื่อนที่ในแนวราบระหวางพื้นสองชั้น ทั้งสองทิศทาง 
Element Force แสดงคาแรงตางๆ ที่เกิดขึน้ในเอลิเมนตแบบแผน 
Element Force Solid แสดงคาแรงตางๆ ที่เกิดขึ้นในเอลิเมนตแบบตัน 
Mode Shapes แสดงคาการเสียรูปของจุดตอ สําหรับทุกโหมด (Mode) 
Entire Table แสดงรายการตารางเหล็กที่เลือกใช 
Section Displacement ทําการคํานวณและแสดงคาการเสียรูปของหนาตัดที่เลือก 

คาอยูในระบบพิกัดโกลบอล 
Analysis Results มีคาเทากับคําสั่ง Joint Displacements, Support Reactions และ 

Mode Shapes รวมกัน  
Member Section Forces แสดงแรงในหนาตัด (ตามที่กําหนดไวโดยคําสั่ง Section) 

สําหรับชิ้นสวนที่เลือก เชน แรงตามแนวแกน แรงเฉือน โมเมนต ในรปูแบบตาราง 
 Member Stresses แสดงคาหนวยแรงทีจ่ดุเริ่มและจดุปลายของชิ้นสวน และทุก
หนาตัดทีก่ําหนดสําหรับชิ้นสวนที่เลือก 
 
 
 
 
 
 
 
 
 
 

 
ภาพที่ 2.38  ตัวเลือกการแสดงผลในขั้นตอนหลังการวเิคราะห 

 
หนาหลัก Design 

เปนขั้นตอนการกําหนดคาตวัแปร (Parameter) ตางๆ ที่จําเปนใหแกโปรแกรม เพื่อนําไปใช
ในการออกแบบตอไป เมื่อเขาสูหนาหลัก Design ดังภาพที่ 2.39 จะประกอบหนายอย 
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Steel, Concrete, Timber, Aluminum, Footing ซ่ึงแตหนายอยจะมีขอกําหนด (Code) ที่
แตกตางกันตามแตชนิดวัสดทุี่จะออกแบบ แตจะมีขั้นตอนการทํางานโดยรวมคลายกันคือ
เมื่อคลิกที่ Select Parameter…  จะเปนการเลือกตัวแปรที่จะกําหนดในการออกแบบ และ
เมื่อคลิกที่ Design Parameter… จะเปนแกไขคาตัวแปรที่ไดเลือกไวแลว แลวคลิกที่ 
Command เพื่อกําหนดคําสั่งที่ใชในการออกแบบ ดังภาพที่ 2.40  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 2.39 หนาหลัก Design 
 
 
 
 
 
 
 
 

ภาพที่ 2.40a การเลือกตัวแปรที่ตองการ 

เลือกเฉพาะตัวแปรที่ไฮไลท 

เลือกตัวแปรทั้งหมด 

ตัวแปรทั้งหมด ตัวแปรที่เลือก 
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ภาพที่ 2.40b  คําสั่งในการออกแบบ 
 
 
 
 

 
 
 
 
 
 

2.2 การวิเคราะหโครงสราง (Performing Analysis) 
โปรแกรม STAAD/Pro มีกลวิธีคํานวณ (Engines) อยูสองวิธีใหเลือกใชตามความ
เหมาะสม คือ STAAD สําหรับการคํานวณวิเคราะหโครงสรางทั่วๆ ไป และ STARDYNE 
สําหรับการวิเคราะหโครงสรางขั้นสูง  

เมื่อผูใชทําการสรางแบบจําลองสําหรับการวิเคราะหเรียบรอยแลว ตองทําการ
เลือกกลวิธีคํานวณที่เหมาะสม ถาผูใชเลือก STARDYNE จําเปนตองตั้งคาตัวแปรตางๆ 
เพิ่มเติมอีกเพือ่ใหถูกตองและเหมาะสมกบัปญหา  

- คําสั่งในสําหรับการสรางแบบจําลองนอกจากในเพจคอนโทรลแลว ยังมีเพิ่มเติม
ในเมนูบาร แตโดยทั่วไปแลวชุดคําสั่งที่เรียกจากเพจคอนโทรลก็เพียงพอที่จะ
ทํางานได ซ่ึงผูใชสามารถดูไดจากตัวอยางหรือจากคูมือที่มากับโปรแกรม 

- หนายอย Analysis/Print เปนการกําหนดคาการแสดงผลในไฟลแสดงผลของ
โปรแกรม (นามสกุล .ANL) เทานั้น การแสดงผลการวิเคราะหทีห่นาจอหรือการ
ทํารายงานจะกลาวถึงตอไปในหวัขอที ่2.3 

NOTES 

รายละเอียดวิธีการใชชุดคําสัง่ออกแบบควรจะทําการศึกษาใหเขาใจอยางถองแทกอนที่
จะใชงาน ซ่ึงไมขอกลาวถึงในคูมือเลมนี้ 

CAUTION!! 
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2.2 การวิเคราะหโครงสราง 
 

ในการเรยีกดไูฟลผลการวิเคราะห ถาทําการวิเคราะหดวย STAAD สามารถเรียก
จากเมนูบารดวย File > View > Output File > STAAD Output สวน STARDYNE เรียก
จากเมนดูวย File > View > Output File > STARDYNE Output  
 

การวิเคราะหดวย STAAD  
ในการทําการวิเคราะหดวย STAAD ทําไดโดยเรยีกใชคําสั่งจากเมนบูาร Analyze > Run 
Analyze ขณะที่อยูใน Modeling Mode โปรแกรมจะแสดงกลองโตตอบดังภาพที่ 2.41 แลว
เลือกตัวเลือก STAAD Analysis ในแท็บ Analysis Option นอกจากนีผู้ใชยังสามารถทําการ
เปลี่ยนแปลงขอกําหนดการออกแบบ (Design Code) ไดในแท็บ STAAD Design Code 

คลิกที่ Run Analysis โปรแกรมจะทําการวิเคราะหพรอมทั้งออกแบบไปพรอมกัน
ขึ้นอยูกับชุดคาํสั่งที่เตรียมในขั้นตอนการสรางแบบจําลอง ดังภาพที่ 2.42 
 
 
 
 
 
 
 

 
ภาพที่ 2.41 ตัวเลือกกลวิธีคํานวณ 

 
 
 
 
 
 
 
 
 

ภาพที่ 2.42 โปรแกรมทําการประมวลผล 
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การเลือกขอกําหนดในการออกแบบ 
จากภาพที่ 2.41 เมื่อคลิกที่แท็บ STAAD Design Code ผูใชสามารถเลือกขอกําหนดการ
ออกแบบของประเทศตางๆ ตามที่ไดเลือกไวในขั้นตอนการติดตั้ง และถาไมมีการ
เปลี่ยนแปลงโปรแกรมจะใชคาเริ่มตน (Default) ตามที่ผูใชไดเลือกไวในขั้นตอนการติดตั้ง
เชนกัน ผูใชสามารถเปลี่ยนคาเริ่มตนไดดวยการเลือก Change Design Code แลวเลือก
ขอกําหนดทีต่องการ ดังภาพที่ 2.43 
 
 
 
 
 
 
 

ภาพที่ 2.43  การเลือกขอกาํหนดในการออกแบบ 
 

การวิเคราะหดวย STARDYNE 
จากภาพที่ 2.41 ถาทําการเลือก Stardyne Advance Analysis โปรแกรมจะแสดงกลอง
โตตอบดังภาพที่ 2.44 ซ่ึงประกอบดวยตัวเลือกการวิเคราะห ดังภาพที่ 2.44 และตัวเลือก
ประเภทของเอลิเมนต ดังภาพที่ 2.45 
 
 
 
 
 
 
 

 
ภาพที่ 2.44  ตัวเลือกวิธีการวิเคราะห 
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ภาพที่ 2.45  ตัวเลือกประเภทของเอลิเมนต 
 
2.3 การแสดงผลการวิเคราะห (Post Processing) 

ขั้นตอนสุดทายในการทํางานคือการแสดงผลการวิเคราะห โดยเขาสูโหมดหลังการ
ประมวลผล (Post Processing Mode) STAAD/Pro สามารถทําการแสดงผลการวเิคราะห
ทางหนาจอ (On Screen) เพื่อทําการตรวจสอบในเบื้องตน ซ่ึงผูใชสามารถเรียกดู การเสีย
รูป (Displacements) แรง (Forces) และหนวยแรง (Stresses) ทั้งการแสดงแบบกราฟก และ
แสดงเปนตวัเลข  
 เมนูบารในโหมดหลังการประมวลผล มีลักษณะเชนเดยีวกันกับโหมดการสราง
แบบจําลอง ยกเวนจะเพิ่มเตมิเมนู Results และ Reports  
 นอกจากนี้ STAAD/Pro ยังสามารถสรางเอกสารรายงาน (Report) แลวสามารถสั่ง
พิมพ (Print) ออกทางเครื่องพิมพไดอยางงายดาย ซ่ึงประกอบดวยขอมูลตารางตัวเลขและ
รูปภาพตามที่เลือก โดยการสรางรูปภาพทําไดโดยการเรยีกใชคําสั่ง Edit > Take Picture 
จากเมนูบาร หรือเลือกไอคอนจากทูลบารดังภาพที ่ 2.46 ก็ไดเชนกนั ซ่ึงจะทําการ
บันทึกภาพกราฟกที่อยูในเมนวินโดวในขณะนั้น แลวเกบ็ไวในแฟมภาพ (Album)  
 
 

 
 

ภาพที่ 2.46 ไอคอนบันทึกภาพ 
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การตั้งคาผลลพัธ (Results Setup) 
ทันทีที่เขาสูโหมดหลังการประมวลผล ดวยการเลือกจากเมนู Mode > Post Processing 
หรือจากไอคอนบนทูลบาร โปรแกรมจะแสดงกลองโตตอบ Results Setup เพื่อใหผูใช
เลือกตัวเลือกการแสดงผล ดังแสดงในภาพที่ 2.47  
 
 
 
 
 
 
 
 
 
 

ภาพที่ 2.47 ตัวเลือกการตัง้คาผลลัพธ 
 
สวนแรกคือการเลือกชุดน้ําหนักบรรทุก (Load Cases) ที่ตองการใหนํามาวิเคราะหเพื่อ
แสดงผล ดังภาพที่ 2.47 โดยคลิกเลือกที่ชุดน้ําหนักบรรทุกที่ตองการแลวใชเครื่องหมาย > 
ยายจากซายไปขวาเพื่อทําการเลือก เครื่องหมาย >> หมายถึงเลือกชุดน้ําหนักบรรทุก
ทั้งหมด สวนเครื่องหมาย < และ << จะเปนการยายจากขวามาซาย เพือ่เปนการยกเลกิ 
 
 
 

การสรางรายงานสามารถทําไดสองวิธี คือ  
- จากไฟลผลลัพธของ STAAD/Pro (.ANL) ซ่ึงสามารถเรียกดูไดจากเมนู File > 

View > View Output  ขอมูลที่แสดงในไฟลนี้ไดจากการกําหนดใน Pre-
Analysis Print และ Post-Analysis Print ตามที่ไดกลาวมาแลว   

- และจาก Report Setup ในโหมดหลังการประมวลผล ซ่ึงจะกลาวถึงในหวัขอนี ้

NOTES 

รูปแบบเครื่องหมาย > , >> , < , << จะมีใชอยูโดยทัว่ไปในกลองโตตอบของโปรแกรม 
ลวนแตมีรูปแบบวิธีการใชอยางเดยีวกัน คอืการยายสิ่งที่เลือกและยกเลกิการเลือก 

NOTES 
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เมื่อทําการเลือกชุดน้ําหนักบรรทุกแลว สามารถเลือกขอบเขตการแสดงผล (Range) ไดจาก
แท็บ Range ดังแสดงในภาพที่ 2.48 ซ่ึงถาไมเปลี่ยนแปลงคาเริม่ตนของโปรแกรมจะ
หมายถึงเลือกโครงสรางทั้งหมด 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 2.48 ตัวเลือกขอบเขตของการแสดงผล 
 

เพจคอนโทรลสําหรับโหมดหลังการประมวลผล (The Pages in  Post Processing Mode) 
หนาหลักและหนายอยสําหรับโหมดหลังการประมวลผล แสดงดังภาพที่ 2.49 และสรุป
เปนคําอธิบายไดในตารางที่ 2.02 ดังตอไปนี้ 
 
 

 
ภาพที่ 2.49 เพจคอนโทรล 

 
ตารางที่ 2.02 คําอธิบายเพจคอนโทรล 

หนาหลัก หนายอย จุดประสงค 
Node Displacement แสดงคาการเสียรูปของจุดตอและหนาตัดที่เลือกในองคอาคาร 

เปนรูปแบบตารางตัวเลข พรอมดวยภาพกราฟก 
 Reactions แสดงคาแรงปฏิกิริยาที่จุดรองรับ ทั้งในรูปแบบตารางตัวเลขและ

ภาพกราฟก 
Beam Forces แสดงคาแรงและโมเมนตขององคอาคาร ทั้งในรูปแบบตาราง

ตัวเลขและภาพกราฟก 

จํานวนหนาตัดในชิ้นสวนที่ตองการใหแสดงผลการวิเคราะห 

กําหนดโดยชวงของหมายเลขจุดตอหรือองคอาคาร 
กําหนดโดยคุณสมบัติหนาตัด 
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หนาหลัก หนายอย จุดประสงค 
 Stress แสดงคาหนวยแรงขององคอาคาร ทั้งในรูปแบบตารางตัวเลข

และภาพกราฟก 
 Failure แสดงแผนภาพการวิบัติและตารางสรุป 
 Graph แสดงคาแรงและโมเมนต โดยสามารถเลือกดูไดทีละช้ินสวน

พรอมแผนภาพแรงเฉือน แรงตามแนวแกน โมเมนต  
Plate Contour แสดงเสนช้ันของหนวยแรงสําหรับเอลิเมนตแบบแผน 
Solid Contour แสดงเสนช้ันของหนวยแรงสําหรับเอลิเมนตแบบตัน 
Animation Animate แสดงการเสียรูป (การแอนตัว) เปนภาพเคลื่อนไหว 
Reports Report Setup จัดทํารายงานเปนรูปเลมที่สามารถพิมพออกทางเครื่องพิมพได 

 
หนายอย Node > Displacement 

เมื่อเขาสูหนายอยนี้ โปรแกรมจะแสดงคาการเสียรูปของจุดตอ และหนาตัดขององคอาคาร
ตามที่ไดเลือกไว ในรูปแบบตารางตัวเลข ดังภาพที่ 2.51 พรอมทั้งแสดงผลเปนในรปูแบบ
กราฟกดังภาพที่ 2.50 พรอมกันดวย ในตารางขอมูลจะแสดงคาสูงสุดและต่ําสุดของการเสีย
รูปไวดวย ตารางขอมูลในขั้นตอนนี้มีสองตารางคือ 
 ตาราง Node Displacement ซ่ึงในแท็บ All จะแสดงคาการเสียรูปที่จุดตอ สําหรับ
ทุกชุดน้ําหนักบรรทุก และทุกดีกรีความอิสระ ดังภาพที่ 2.51a สวนแท็บ Summary จะ
แสดงคาเสียรูปสูงสุดและต่าํสุดของแตละดีกรีความอิสระ ดังภาพที่ 2.51b 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 2.50 การเสียรูปของโครงสราง 
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ภาพที่  2.51a ตาราง Node Displacement 
 
 
 
 
 
 

 
ภาพที่  2.51a ตาราง Node Displacement 

 
 สวนตาราง Beam Relative Displacement Detail ในแท็บ All จะเพิ่มเติมคาการ
เสียรูปที่หนาตดัขององคอาคารตามที่ไดเลือกไว สําหรับทุกชุดน้ําหนักบรรทุก และทกุดีกรี
ความอิสระเชนกัน สวนแทบ็ Summary กจ็ะเพิ่มเติมคาการเสียรูปสูงสุดและต่ําสุดของหนา
ตัดที่เลือกไวมาเปรียบเทียบดวย ซ่ึงจะมีลักษณะคลายคลึงกับภาพที่ 2.51 

 
หนายอย Node > Reactions 

จะแสดงคาปฏกิิริยาที่จุดรองรับ ทั้งในรูปการแสดงผลกราฟก ดังภาพที่ 2.52 และในรูป
ตารางสรุปเปนขอมูลตัวเลขดังภาพที่ 2.53 ซ่ึงประกอบดวยสามสวนคือ แท็บ All จะแสดง
คาปฏิกิริยาที่จดุรองรับสําหรับทุกชุดน้ําหนกับรรทุก สวนแท็บ Summary จะแสดงคาแรง
ปฏิกิริยาสูงสุดและต่ําสุดสําหรับแตละดกีรีความอิสระ โดยจะระบุดวยวาคาดังกลาวเกดิ

คาสูงสุด 

คาสูงสุด 
ชุดน้ําหนักบรรทุก การเลื่อนที่ การหมุน 
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จากชุดน้าํหนกับรรทุกชุดใดและที่จดุตอใด และแท็บ Envelope จะแสดงคาเอนเวลโลป
สําหรับแตละจุดรองรับ ดังแสดงในภาพที่ 2.53 
 
 
 
 
 
 
 
 
 
 
 
 

 
ภาพที่ 2.52 แรงปฏิกิริยาทีจุ่ดรองรับ 

 
 
 
 
 
 

 
 
 
 
 
 

ภาพที่ 2.53 ตารางแสดง Support Reactions 
 

คาแรงปฏิกิริยา 
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หนายอย Beam > Forces 
ขั้นตอนนี้จะแสดงแรงที่ปลาย (End Forces) ขององคอาคาร ซ่ึงจะแสดงในรูปกราฟกดัง
ภาพที่ 2.54 พรอมทั้งตารางตัวเลขสรุป ซ่ึงประกอบดวยสามแทบ็เชนเดยีวกับ ตาราง
สําหรับแรงปฏิกิริยา ดังแสดงในภาพที่ 2.55  
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 2.54 แรงที่ปลายขององคอาคาร 
 
 
 
 
 
 

 
 

ภาพที่ 2.55 ตารางแสดง Beam End Forces 
 

 
 
 

ผูใชสามารถแกไขคาสเกลของภาพกราฟกที่แสดงในเมนวินโดว ไดโดยเรียกใชคําสั่ง 
Results > Scale จากเมนูบาร  

NOTES 
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หนายอย Beam > Stresses 
ใชแสดงผลหนวยแรง (ทัง้หนวยแรงเนือ่งจากแรงตามแนวแกนและแรงดดั) ในรูปแบบ
กราฟกดังภาพที่ 2.56 และเปนตารางสรุปดังภาพที่ 2.57 ซ่ึงประกอบดวยสองสวน ไดแก 
แท็บ All จะแสดงคาหนวยแรงที่มุม (Corner) ทั้งสี่ในทุกๆ หนาตัดทีก่ําหนดสําหรับทุกองค
อาคาร พรอมทั้งแสดงคาหนวยแรงดึงและหนวยแรงอัดสูงสุดที่หนาตดัดังกลาวดวย สวน
แท็บ Max Stresses จะแสดงตารางสรุปคาหนวยแรงดงึและหนวยแรงอัดสูงสุดสําหรับแต
ละชุดน้ําหนักบรรทุก พรอมทั้งบอกตําแหนงที่เกิดดวย 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 2.56 หนวยแรงในองคอาคาร 
 
 
 
 
 
 
 
 
 

ภาพที่ 2.57 ตารางแสดง Beam Combined Stress Detail 
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หนายอย Beam > Failure 
ขั้นตอนนี้ โปรแกรมจะแสดงคาการวิบัติขององคอาคารในโครงสราง ดังภาพที ่2.58 ในรูป
ของอัตราสวนวิบัติ (Fail Ratio) ดังแสดงในตารางที่ 2.59 ซ่ึงเปนคาที่ไดจากการตรวจสอบ
หนาตัดทีเ่ลือกกับการออกแบบตามขอกําหนด (Code Check) พรอมทั้งแสดงรายละเอียด
คุณสมบัติของหนาตัดเอาไวดวย 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

ภาพที่ 2.58 องคอาคารที่เกิดการวิบัต ิ
 
 
 
 
 
 
 
 
 

ภาพที่ 2.59 ตารางแสดง Design Results 

องคอาคารที่วิบัติ 

องคอาคารที่วิบัติ 
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หนายอย Beam > Graph 
ขั้นตอนนี้ผูใชสามารถเรียกดแูผนภาพของโมเมนตดัด (Bending Moment) และแรงตางๆ 
เชน แรงตามแนวแกน (Axial) หรือแรงเฉือน (Shear yy) เปนตน สําหรับองคอาคารที่เลือก
ทีละชิ้นสวน ดังแสดงในภาพที่ 2.60  

โดยปกตแิลวคาเริ่มตนของการแสดงแผนภาพจะประกอบดวย Axial, Shear yy, 
Bending zz แตผูใชสามารถกําหนดคาการแสดงผลใหมไดโดยคลิกที่แผนภาพ (Diagram) 
ที่ตองการแกไข แลวเรียกคําสั่ง View > Diagrams จากเมนูบาร โปรแกรมจะแสดงกลอง
โตตอบดังภาพที่ 2.61 แลวทําการเลือกการแสดงผลตามตองการ 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 2.60  แผนภาพแรงตางๆ ขององคอาคาร 
 
 
 
 

 
 
 
 

ภาพที่ 2.61  ตัวเลือก Diagrams 

เลือกองคอาคารที่ตองการใหแสดงผล 

Bending Moment Diagram 

Shear Force Diagram 

Axial Force Diagram 

ใชระบบพิกัดโลคอล 
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หนายอย Plate > Contour 
ขั้นตอนนี้โปรแกรมจะแสดงเสนชั้น (Contour) ของหนวยแรง ที่เกดิขึ้นบนเอลิเมนตแบบ
แผน ทันทีที่เขาสูหนายอย Plate > Contour โปรแกรมจะแสดงกลองโตตอบ Plate Stress 
Contour ดังภาพที่ 2.62 เพื่อใหผูใชกําหนดคาตางๆ ที่จําเปน เมือ่เสร็จแลวคลิกที่ OK 
โปรแกรมจะทาํการคํานวณและแสดงผลกราฟกของเสนชัน้หนวยแรง พรอมดวย
ตารางขอมูลดังภาพที่ 2.63  
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 2.62  กลองโตตอบ Plate Stress Contour 
 

 
 
 
 
 
 

 
 

ภาพที่ 2.63 ตารางแสดง Plate Center Stresses 
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หนายอย Solid > Contour 
มีขั้นตอนการทํางานคลายคลึงกับ หนายอย Plate > Contour แตใชสําหรับแสดงเสนชั้น
หนวยแรงของเอลิเมนตแบบตัน 
 

หนายอย Animation > Animate 
โปรแกรม STAAD/Pro มีความสามารถในการแสดงภาพเคลื่อนไหว (Animation) เพื่อ
แสดงการเสียรูป ของโครงสรางเนื่องจากชุดน้ําหนักบรรทุกตางๆ ได รวมไปถึงการ
เปลี่ยนแปลงของหนวยแรงตามเวลาไดดวย เมื่อเขาสูหนายอย Animation > Animate 
โปรแกรมจะแสดงกลองโตตอบ Animation ดังภาพที่ 2.64 เพื่อใหผูใชตั้งคาการใชงานตาม
ความตองการ  
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 2.64 กลองโตตอบ Animation 
 

หนายอย Reports > Report Setup 
เปนขั้นตอนสดุทาย ชวยใหผูใชสามารถจัดทํารายงาน (Report) เปนรูปเลม ซ่ึงอาจจะ
ประกอบไปดวยตารางแสดงผล ขอมูลตางๆ ตามที่ไดเลือกไว พรอมทั้งภาพกราฟกซึ่งได
จากคําสั่ง Take Picture อยูในรายงานดวย ซ่ึงทันที่ทีผูใชเขาสูหนายอย Report > Report 
Setup โปรแกรมจะแสดงกลองโตตอบ Report Setup ดังแสดงในภาพที่ 2.65 เพื่อใหผูใช
ทําการกําหนดคาตัวเลือกของรายงาน ซ่ึงประกอบไปดวยสวนยอยดังตอไปนี ้
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 แท็บ Items ใหผูใชเลือกตารางขอมูลที่ตองการจากหมวดหลักๆ คือ ขอมูลนําเขา 
(Input) ผลการคํานวณ (Output) ภาพ (Picture) และรายงาน (Report) ที่เคยสรางและบนัทึก
ไว ดังภาพที่ 2.65a 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 2.65a   Report Setup – Items 
 

 แท็บ Load Cases เปนตัวเลือกชุดน้ําหนักทีต่องการใหแสดงผลในรายงาน ดังภาพ
ที่ 2.65b 
 
 
 
 
 
 
 
 
 

 
ภาพที่ 2.65b Report Setup – Load Cases 

 
 

รายการที่เลือกแลว รายการที่มีใหเลือก 

หมวดหลัก 
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แท็บ Ranges เปนการกําหนดชวงของโครงสรางที่ตองการใหแสดงผล ถาไมแกไข 
คาเริ่มตนของโปรแกรมคือแสดงผลทั้งหมด ดังภาพที่ 2.65c 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 2.65c Report Setup – Ranges 
 

แท็บ Picture Album ใชเรียกดูตัวอยางภาพที่บันทึกจากคําสั่ง Take Picture ซ่ึงภาพ
เหลานี้สามารถแทรกประกอบไปในรายงานได โดยการเลือกหมวด Picture ในแทบ็ Items 
ดังภาพที่ 2.65d 

 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 2.65d Report Setup – Picture Album 
 

เลือกทั้งหมด 

เลือกตามคุณสมบัติหนาตัด 

กําหนดชวงตามหมายเลขจุดตอ
หรือองคอาคาร 

ช่ือที่ใชอางถึงในรายงาน 

คําบรรยายภาพซึ่งจะแสดงไปพรอมกับภาพดวย 

ลบภาพที่ไมตองการ 

กําหนดใหแสดงผลเต็ม
หนากระดาษ 
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แท็บ Name and Logo ผูใชสามารถที่จะกาํหนดชื่อและสัญลักษณของตน หรือของ
หนวยงานใหแสดงที่หัวกระดาษของรายงานได โดยตองจัดทําชื่อและสัญลักษณใหเปน
แฟมภาพนามสกุล .WMF แลวจึงเรียกใชงานได หรือพิมพเปนขอความก็ได ดังภาพที่ 
2.65e 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 2.65e Report Setup – Name and Logo 
 

แท็บ Options เปนตัวเลือกรูปแบบหนากระดาษของรายงาน เชน หวักระดาษ ทาย
กระดาษ หมายเลขหนา และการกําหนดแบบอักษรที่จะใชในรายงาน ดังภาพที่ 2.65f 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 2.65f Report Setup – Option 
 

พิมพขอความที่ตองการ 

เลือกไฟลภาพที่ตองการ 

เลือกรูปแบบตัวอักษร 
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เมื่อทําการเลือกคาตาง ๆ เรียบรอยแลว ใหคลิกที่ OK ผูใชจะสามารถเรียกดู
ตัวอยางกอนพมิพ (Print Preview) ไดจากเมนูบาร File > Print Preview Report หรือจาก
ไอคอน  บนทูลบารก็ได โปรแกรมจะแสดงตัวอยางใหดูกอนพิมพ ดังภาพที่ 2.66 ซ่ึง
ผูใชสามารถกลับไปแกไขรายงาน ไดโดยคําสั่ง File > Report Setup… จากเมนูบารหรือ
จากไอคอน  บนทูลบารก็ได  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 2.66  ตัวอยางรายงาน 
 
 

 
 

 


